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Учебное пособие предназначено для развития навыков работы в графическом редакторе Adobe Photoshop. Учебное пособие используется при изучении программного модуля «Обработка отраслевой информации» при обучении студентов по специальности «Прикладная информатика» 230701. Практикум рекомендуется использовать для работы в классе, а также при организации дополнительных, факультативных занятий и элективных курсов. Также его можно использовать в качестве самоучителя и домашней работы.
Рассмотрено и одобрено на заседании предметно цикловой комиссии
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[bookmark: _Toc398806105]Теоретическая часть.
[bookmark: _Toc23782368][bookmark: _Toc26976279]Редакторы растровой графики.
[image: instr_02][image: instr_01]Microsoft Paint - простой (или лучше сказать - простейший) редактор, входящий в стандартную поставку операционных систем Microsoft. Он обладает набором простейших функций (кисточка, карандаш, резинка и т.д.), которые позволяют создавать незамысловатые картинки. К сожалению, для обработки графики он практически не пригоден. Вы уже, наверное, сталкивались с этой программой и знаете ее возможности. Картинка, которую вы видете справа, нарисована в Paint'е. Наверное, это большее, на что способен этот редактор. 
Существует еще ряд редакторов (Microsoft Photo Editor, Microsoft Photo DRAW), также позволяющих реализовать простейшие задачи, но не удовлетворяющих запросам профессионалов.
[image: instr_03]Adobe Photoshop - на сегодняшний день это самый мощный пакет для профессиональной обработки растровой графики. Это целый комплекс, обладающий многочисленными возможностями модификации растрового рисунка, имеющий огромный набор различных фильтров и эффектов, причем есть возможность подключать инструменты независимых производителей. Пакет предлагает, например, средства для восстановления поврежденных изображений, ретуширования фотографий или создания самых фантастических коллажей, которые только может позволить себе наше воображение. В общем, потенциал этого пакета поистене огромен. Начиная с версии 5.5 в пакет включена программа Adobe ImageReady, предоставляющие огромные возможности по обработке графики под WEB (оптимизация изображений, создание анимированных gif, «разрезание» картинок на более мелкие и т.д.). Девиз разработчиков Adobe Photoshop - «Camera of your mind» - предполагает не только техническое совершенство, но и полную свободу творчества, на которую человек, работающий с этой программой, просто обречен. Естественно, что каждый программный продукт не лишен некоторых недостатков. Фирма Adobe постоянно предпринимает все возможные усилия по совершенствованию своей продукции.
PhotoPaint - еще один не менее известный графический редактор (из пакета Corel Draw) для обработки растровой графики, конкурирующий с Adobe Photoshop. Здесь также имеются все необходимые инструменты для обработки графики, разнообразные фильтры, текстуры... Разница лишь в удобстве работы, интерфейсе и скорости наложения фильтров - наложение происходит немного медленнее. 
Painter - редактор предоставляет великолепные возможности для эмуляции реальных инструментов рисования: графит, мел, масло и т.д. Также позволяет имитировать фактуру поверхности материалов, живопись, создавать анимацию. Очень удобен для разработки фоновых рисунков или сайтов в стиле живописи. Пользуясь это программой чуствуешь себя настоящим художником.

Photoshop открывает файлы в 28-ми форматах и сохраняет в 16. Собственный формат Photoshop - PSD – формат, оптимизированный для возможностей и функций Photoshop. Открываются и сохраняются файлы такого формата быстрее, чем в любом другом. Наиболее распространены также форматы JPEG, BMP, GIF, TIFF.

[bookmark: _Toc398806106]Заставка и пригласительное окно программы.

В результате двойного щелчка на значке Photoshop открывается окно программы с заставкой, где указано, какие компоненты в данный момент загружаются и приведены сведения, внесенные при установке Photoshop, в частности ваше имя и серийный номер программы. Здесь также представлены имена дизайнеров и разработчиков Photoshop.
Когда загрузка программы завершится, заставка исчезнет. После исчезновения заставки вы увидите пригласительное окно Adobe Photo shop. Этот элемент программы предназначен для немедленного доступа к интерактивным руководствам, а также советам и подсказкам от лучших специалистов по Photoshop. Кроме того, отсюда можно сразу перейти к настройке цветов программы, что важно для обеспечения соответствия изображений, выводимых на экран и полученных после печати. Ознакомившись со всеми ссылками пригласительного окна, щелкните на кнопке Close (Закрыть), чтобы оказаться в рабочей среде Photoshop.

[bookmark: _Toc398806107]Интерфейс Photoshop

Графический пользовательский интерфейс- это средства взаимодействия программы с пользователем. Другими словами, с помощью интерфейса вы даете указания программе, а она выполняет ваши команды. На рис. показано, как выглядит интерфейс Photoshop. В левой части главного окна выводится
вертикальная панель инструментов, а в правой -четыре группы палитр. Вверху располагается
строка меню. В этих трех областях сосредоточены все средства и команды программы, связанные с редактированием изображений.
[image: ]









[bookmark: _Toc398806108]Главное меню

Большинство операций выполняется с помощью команд меню, расположенных в верхней строке главного окна, называемой строкой меню. Программа содержит девять раскрывающих меню:
•File (Файл) - этим меню приходится пользоваться в основном в начале и в конце работы, так как большинство его функций связано с созданием, открытием и сохранением файлов. 
•Edit (Редактирование)– в этом меню находятся основные команды редактирования, многие из которых есть и в других программах. 
•Image (Изображение)– подменю, созданное для работы непосредственно с изображением. Многие его команды придется применять почти в каждой работе. 
•Layer (Слои)– работа со слоями. 
•Select (Выделение)– создание и редактирование выделения. 
•Filter (Фильтры)– в этом подменю находятся фильтры – дополнительные модули PhotoShop, выполняющие самые разные функции. 
•View (Вид)– различные настройки интерфейса, помогающие пользователю в работе. 
•Window (Окно)– с помощью данного подменю вы управляете отображением палитр и размещением документов на экране. 
•Help (Помощь)– команды справочной системы, помогут получить доступ к руководству по программе Photoshop.

[bookmark: 2][bookmark: _Toc398806109]Панель инструментов

Панель инструментов Photoshop включает значки 22 инструментов. Если рядом со значком инструмента имеется маленькая черная стрелка, щелкните на ней и не отпускайте кнопку мыши в течение одной секунды – раскроется дополнительная панель со списком инструментов, входящих в ту же группу. Задержите указатель мыши на любом значке, и появится маленькая подсказка с именем инструмента и клавишей, используемой для его выбора. Чтобы выбрать инструмент, достаточно щелкнуть на его кнопке. Дальнейшие действия зависят от выбранного инструмента.

[image: ]
[bookmark: 4]
[image: ]
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[bookmark: _Toc398806110]Панель параметров

По умолчанию панель параметров выводится в верхней части экрана непосредственно под строкой меню. Здесь отображаются параметры выбранного инструмента.
[image: ]

Панель параметров после выбора инструмента Brush

[bookmark: _Toc398806111]Палитры

Многие инструменты и операции Photoshop представлены на так называемых палитрах – вкладках в небольших окнах, расположенных обычно вдоль правого края главного окна Photoshop. Эти палитры позволяют быстро и эффективно выполнять операции над изображением, экономя время, которое занимает выбор команд из меню и установка параметров в диалоговых окнах.
Вывести или скрыть определенную палитру можно щелчком на ее имени в меню Window (Окно). Отобразить или скрыть все палитры вместе с панелью инструментов и панелью параметров поможет клавиша Tab. А если необходимо скрыть палитры, но оставить при этом на экране панель инструментов, следует воспользоваться клавишами Shift+Tab.

[bookmark: _Toc398806112]Окно изображения

Когда вы создаете или открываете уже имеющееся изображение, оно выводится в новом окне, пример которого представлен на рис. Это окно можно как перетаскивать в пределах рабочего пространства Photoshop, так и менять его размер. Чтобы переместить окно, следует захватить его мышью за полосу заголовка, а для изменения размера — потянуть за любую из четырех границ окна. В окне изображения содержится информация о документе.

[bookmark: _Toc398806113]Основные операции с изображениями
[bookmark: _Toc398806114]Открытие документа

Получив изображение с помощью сканера или цифрового фотоаппарата и сохранив его на диске, вы можете загрузить этот файл в Photoshop. Откройте файл . jpg.
· Выполните команду File► Open (Файл ► Открыть).
Откроется диалоговое окно, показанное на рис. В этом окне представлено содержимое диска. Команду «Открыть» можно вызвать двойным щелчком мыши по пустому месту в окне программы. 
· Выделите файл . jpg. и в окне будет выведена миниатюра содержащегося в нем изображения.
· Нажмите кнопку «Открыть».
[image: ]

[bookmark: _Toc398806115]Сохранение файлов

[bookmark: 5]Существует шесть способов сохранения документа Photoshop на диске. Они представлены командами меню File (Файл), к которым относятся: Save As (Сохранить как), (Сохранить), ► Pathsto Illustrator (Экспорт ► Контуры в Illustrator), Save for Web (Сохранить для Веб) и Save a Version (Сохранить версию). Сюда можно также отнести флажок As а Сору (Сохранить как копию), имеющийся в окне Save As. Далее описаны некоторые из этих команд:
•Команда File ► Save As (Файл ► Сохранить как) предназначена для сохранения документа в указанном вами месте на диске. В открываемом ею диалоговом окне Save As (Сохранить как) предусмотрены элементы управления для задания имени документа и выбора его формата, а также другие элементы. Флажки в области Save (Сохранить) используются для настройки документа под конкретные нужды. Выбирая флажок As а Сору (Как копию), вы должны знать, что будет создан новый документ, идентичный исходному. 
•Команда сохранения документа File► Save (Файл ► Сохранить) обновляет файл, с которым вы работаете, записывая в него текущую версию изображения. Периодическое сохранение документа защищает вас от потери информации в случае отказа системы.
•Команда File► Save for Web (Файл ► Сохранить для Веб) позволяет подготовить файлы для публикации в Веб.
•Команда File► Save aVersion (Файл ► Сохранить версию) дает возможность сохранить очередную версию файла с соответствующими комментариями и другой информацией.

[bookmark: _Toc398806116]Создание заметок

[image: ]В Photoshop имеется два инструмента, позволяющих присоединять к изображению произвольные заметки либо в текстовой форме, либо в звуковой.
Текстовая заметка создается следующим образом.
1. Выберите на панели инструментов инструмент Notes (Заметки)  или нажмите клавишу N.
2. Щелкните на изображении, в этом месте появится область для ввода текста.
3. Введите текст заметки, как показано на рис., и щелкните на кнопке закрытия текстового окна.
4. Для того чтобы прочитать текст заметки, дважды щелкните на ее изображении.

[bookmark: _Toc398806117]Просмотр изображения

Когда вы открываете изображение в программе Photoshop, оно выводите целиком и, как правило, в реальных размерах. Однако во время работ: приходится увеличивать или, наоборот, уменьшать масштаб изображения на экране. Такое изменение масштаба отображения никак не влияет на его физические размеры.

[bookmark: _Toc398806118]Инструмент Zoom

Для увеличения и уменьшения масштаба отображения документа на экране служит инструмент Zoom (Масштаб).
Выберите его на панели инструментов, щелкнув на соответствующей кнопке или нажав клавишу Z. Когда вы подведете указатель мыши к изображению, он примет вид лупы со знаком плюс внутри, указывающим на то, что инструмент работает в режиме увеличения. Щелкните на изображении мышью, и его масштаб увеличится. Каждый следующий щелчок будет увеличивать изображение сильнее, пока оно не достигнет максимального увеличения - 1600 %. Если во время выполнения щелчка удерживать клавишу Alt, инструмент будет работать в режиме уменьшения масштаба, а его указатель примет вид лупы со знаком минус. Изображение можно уменьшить до 1 пиксела.

[bookmark: _Toc398806119]Прокрутка

Средства и приемы прокрутки позволяют передвигать изображение в окне, когда оно не помещается в него целиком.
•Инструмент Hand (Рука). 
Щелкните на кнопке с изображением руки на панели инструментов или нажмите клавишу Н. Затем, нажав кнопку мыши в любом месте изображения и неотпуская ее, двигайте изображение.
[bookmark: 6]•Полосы прокрутки. 
В Photoshop справа и снизу окна имеются полосы прокрутки. Захватите движок и перемещайте его в ту или другую сторону либо щелкните с одной или другой стороны движка, чтобы прокрутить содержимое окна.
•Клавиатура. 
Для прокрутки изображения можно воспользоваться клавишами перемещения, расположенными на основной и расширенной клавиатуре. 

Клавиатурные команды прокрутки
Клавиши                  Прокрутка
PgUp                        Вверх
Shift+PgUp              Немного вверх
PgDn                        Вниз
Shift+PgDn              Немного вниз
Ctrl+PgUp               Влево
Shift+Ctrl+PgUp     Немного влево
Ctrl+PgDn               Вправо
Shift+Ctrl+PgDn     Немного вправо

Быстрая навигация
Более бы стрые способы увеличения или прокрутки. Таких способов несколько.
•Вывод нужного фрагмента изображения. Выберите инструмент Zoom (Масштаб) и, удерживая нажатой кнопку мыши, начертите прямоугольник вокруг области, которую хотите увеличить. Когда вы отпустите кнопку, выделенный фрагмент займет все окно документа.
•Восстановление масштаба до 100 %. Дважды щелкните на кнопке Zoom (Масштаб) на панели инструментов.
•Изменение масштаба без инструмента Zoom (Масштаб). Нужно нажать клавиши Ctrl+Пробел— для увеличения изображения или клавиши Alt+Пробел — для его уменьшения, в результате чего указатель примет вид увеличительного стекла со знаком плюс или минус соответственно, а затем, удерживая клавиши нажатыми, следует один или несколько раз щелкнуть мышью до достижения требуемого масштаба. Когда вы отпустите клавиши, указатель примет вид того инструмента, с которым вы работали.
•Переход к другому фрагменту с помощью инструмента Hand (Рука). Нажмите клавишу пробела - указатель мыши примет вид инструмента Hand (Рука) - и, удерживая ее нажатой, перемещайте изображение в окне. 

[bookmark: _Toc398806120]Палитра Navigator

Палитра Navigator (Навигатор)— своего рода интерактивная карта изображения, на которой показана его миниатюра, где красной рамкой выделен отображаемый в окне фрагмент.
Основные элементы этой палитры:
•Поле просмотра. В центре палитры представлена миниатюра изображения, а на ней красной прямоугольной рамкой выделена та его часть, которая отображается в окне документа. Поместите указатель мыши внутрь рамки и, удерживая кнопку мыши нажатой, перетащите рамку в другое место миниатюры. Изображение в окне соответственно сдвинется. 
•Ползунок для изменения масштаба. Для того чтобы изменить масштаб изображения в окне документа, сдвиньте вправо или влево ползунок, расположенный внизу палитры.
•Кнопки Zoom In (Увеличить) и Zoom Out (Уменьшить). Кнопка с изображением маленьких гор слева от ползунка уменьшает масштаб изображения, а кнопка с большими горами справа —увеличивает.
•Поле масштаба. В левом нижнем углу палитры Navigator (Навигатор) можно ввести определенный процент масштабирования изображения.
[bookmark: 7]Меню View Команда View► Zoom In (Вид ► Увеличить) производит то же действие, что и нажатие клавиш Ctrl+«+», а команда View► Zoom Out (Вид ► Уменьшить) - что и нажатие клавиш Ctrl+«-». И то же самое можно сделать с помощью инструмента Zoom (Масштаб) и панели Navigator (Навигатор). Кроме команд увеличения и уменьшения масштаба в меню View (Вид) имеются и другие, представленные ниже.
•Fit On-Screen (По размеру экрана) — выводит изображение с максимальным увеличением, прикотором оно помещается на экране целиком;
•Actual Pixels (Реальный размер) — выводит изображение в масштабе 1:1 относительно разрешения монитора;
•Print Size (Печатный размер) - выводит изображение с таким масштабом, при котором оно будет иметь на экране те же высоту и ширину, что и на бумаге. 

[bookmark: _Toc398806121]Отмена действий

 В Photoshop ведется история работы над изображением, в которую записывается каждая выполняемая операция и соответствующее ей состояние изображения. Эта история хранится на палитре History (История), открываемая командой Window► History (Окно ► История), в виде элементов списка (см. рис). Каждый элемент списка называется состоянием. Для того чтобы отменить одно или несколько действий:
1.Перетащите строку состояния, поместив ее на кнопку с изображением корзины в правом нижнем углу палитры History (История).
[image: ]2.Щелкнув на строке состояния, выберете из меню палитры History (История) команду Delete (Удалить) или можете щелкнуть на кнопке с изображением корзины.
3. Выделите строку состояния. Все строки, расположенные под ней, станут недоступными. Теперь, после выполнения в документе любой операции редактирования, недоступные строки будут удалены.
4. Выполните из меню палитры History (Протокол) команду Clear History (Очистить историю), которая удалит все автоматически сохраненные состояния; снимки же при этом останутся нетронутыми.
5. Активизируйте команду Edit► Purge► Histories (Правка ► Очистить ►История). Программаудалит все состояния, кроме последнего в списке; снимки в этом случае тоже сохранятся. Данное действие отменить нельзя.


[bookmark: _Toc398806122]Выделение области изображения
[bookmark: _Toc398806123]Группа «Marquee Tools»

Rectangular Marquee Tool (Прямоугольная выделенная область). С помощью этого инструмента создаются прямоугольные выделения. Если удерживать Shift во время создания выделения, то оно получится квадратным.
Elliptical Marquee Tool (Эллиптическая выделенная область). Служит для создания овальных выделений. Получить круг можно, зажав Shift.
Single Row Marquee Tool (Строка пикселей). Данный инструмент всего лишь частный случай Rectangular Marquee Tool. Полученное выделение будет размером 1px по высоте, и 100% по ширине.
Single Column Marquee Tool (Столбец пикселей). Получаемые выделения будут размером 100% по высоте, и 1px по ширине.
[bookmark: 8]На практике, если это необходимо, можно использовать дополнительные возможности:
[image: ]
1 › Текущее выделение сбросит предыдущее.
2 › Текущее выделение суммируется с предыдущим. (Альтернативный вариант: зажать Shift до начала создания выделения, при этом рядом с курсором появится знак "+".)
3 › Текущее выделение вычитается из предыдущего. (Альтернативный вариант: зажать Shift+Alt до начала создания выделения, рядом с курсором появится знак "-".)
4 › Результирующим будет пересечение текущего и предыдущего выделений. (Альтернативный вариант: зажать Shift+Alt до начала создания выделения, рядом с курсором появится знак "x".)
5 › "Мягкие" края у выделения. Значение в поле - радиус пера.
6 › Использовать функция сглаживания Anti-alias.
7 › Режим для создания выделений без дополнительных функций 
8 › Фиксированное соотношение ширины и высоты. Задается в виде числа в полях 10 и 11. При соотношении 1х1 вы получаете прямоугольник с равными сторонами, то есть квадрат.
9 › Фиксированный размер выделения. Задается в px в полях 10 и 11.

[bookmark: _Toc398806124]Группа «Lasso Tools»

[image: ]Lasso Tool (Лассо). Служит для создания выделений произвольной формы.
Polygonal Lasso Tool (Многоугольное лассо). Используется для создания многоугольников.
Magnetic Lasso Tool (Магнитное лассо). Принцип работы инструмента Magnetic Lasso Tool -создание выделения по границе (разницы значений цвета между соседними N пикселями). Вам нужно вести курсор мыши возле границы, при этом выделение будет "прилипать" к этой границе.

[bookmark: _Toc398806125]Инструмент «Magic Wand» (Волшебная палочка)

Данный инструмент имеет особенную мощь в отделении объекта от фона, хотя помогает и не всегда. Для получения выделения необходимо нажать на некоторую точку. Программа анализирует пиксели, и если разница значений цвета (анализируемого пикселя и того, что был выбран за основной) меньше значения Tolerance (Допуск) (5), то данные пиксели включаются в результат. (Необходимо понимать, что любой цвет представляется в виде значения - числа. Если в цветовой модели несколько каналов, подсчитывается общая разница). 
[image: ]
[bookmark: 9]1, 2, 3, 4, 6 › такие же, как и для Marquee Tools. 
7 › указывает на то, что нужно анализировать только близлежащие пиксели. Если какие-либо пиксели не включаются в результат, то они действуют как "преграда", дальше которых анализ не происходит.
8 › указывает, что нужно анализировать все слои. Вообще говоря, то изображение, что вы видите перед собой и есть "все слои", с него и будет происходит анализ.
[bookmark: _Toc398806126]Лабораторная работа №1

Тема:«Волшебная палочка».
Цель: научиться использовать инструмент волшебная палочка.
Задание 1:
1. Откройте приложение Adobe Photoshop
2. Загрузите файл Peppers.psd 
[image: media/source_pictures/peppers.zip]
3. Увеличьте масштаб изображения до 200-300% и далее работайте с таким масштабом. Для перемещения по изображению используйте палитру Навигатор или инструмент Рука [image: Инструмент Рука(H)].
4. Используя инструмент Волшебная палочка [image: Инструмент Волшебная Палочка (W)], выделяйте отдельные овощи и с помощью инструмента Заливка [image: Инструмент Заливка (G)]раскрасьте их в разные цвета.
Совет:
a. Отрегулируйте параметр Чувствительность Волшебной палочки так, чтобы овощи выделялись целиком и при этом не захватывались другие элементы (значение должно быть в диапазоне от 0 до 255).
b. Если Заливка закрашивает слишком много или слишком мало, то отрегулируйте параметр Чувствительность (значение должно быть в диапазоне от 0 до 255).
c. Вместо инструмента Заливка можно использовать Кисть [image: Инструмент Кисть (B)]или Аэрограф [image: Включить возможности пульверизатора].
5. В результате у вас получится некоторый абстрактный натюрморт. Готовое изображение сохраните в своей папке.
Готовое изображение
[image: готовое изображение]


Задание 2: 
1. Откройте приложение Adobe Photoshop
[image: media/source_pictures/atheletic.zip]





2. Загрузите файлы atheletic.jpg и landscape.jpg [image: media/source_pictures/landscape.zip]
3. Перейдите к окну с изображением гимнастки Используя инструмент Волшебная палочка [image: Инструмент Волшебная Палочка (W)], выделите фон вокруг гимнастки. Для добавления выделения фона в замкнутом пространстве (ограниченном руками, ногами и др.) к основному выделению, используйте инструмент Волшебная палочка [image: Инструмент Волшебная Палочка (W)], удерживая при этом нажатой клавишу <Shift>.
[image: Выделение изображения]
Совет:
· Отрегулируйте параметр Чувствительность Волшебной палочки так, чтобы выделяемые фрагменты изображения охватывались целиком и при этом не захватывались другие элементы (значение должно быть в диапазоне от 0 до 255).
4. У Вас получился выделенным синий фон. Теперь необходимо выделить саму гимнастку. Для этого инвертируйте выделение, выполнив команду Выделение ► Инвертировать выделение, или воспользуйтесь «горячими» клавишами <Ctrl>+<Shift>+<I>
[image: Выделение изображения]
5. Выделенное изображение поместите в буфер обмена с помощью команды Редактирование ► Копировать (<Ctrl>+<C>)
Перейдите к окну с пейзажем (landscape.jpg).
Вставьте изображение командой Редактирование ► Вставить(<Ctrl>+<V>)
[image: Копировать и вставить выделенное изображение]
6. С помощью инструмента Перемещение [image: Перемещение (V)]выровняйте изображение гимнастки на фоне пейзажа. Готовое изображение сохраните в своей папке.
Готовое изображение
[image: готовое изображение]

[image: media/source_pictures/schtirlitz.zip]Задание 3:
1. Откройте приложение Adobe Photoshop
2. Загрузите файлы: radioCat.jpg и Schtirlitz.jpg 
[image: media/source_pictures/radiocat.zip][image: media/source_pictures/schtirlitz.zip]
3. Сперва необходимо «подготовить» изображение с машиной. Перейдите к окну с файлом Schtirlitz.jpg. С помощью инструмента Кадрирование [image: Кадрирование (С)]выделите область внутри чёрной рамки (см.рисунок) и нажмите <Enter>. В результате останется изображение, находившееся внутри выделения.
[image: Кадрирование изображения]
4. Отрегулируйте цветовую гамму изображения с помощью команды меню Изображение ► Регулировки ► Автоуровни (<Ctrl>+<Shift>+<L>).
[image: Автоуровни]
5. Перейдите к окну с изображением девушки (radioCat.jpg)
Используя инструмент Волшебная палочка [image: Инструмент Волшебная Палочка (W)], выделите фон фокруг девушки.
[image: Выделение изображения]
6. Добавьте к получившемуся выделению не выделившиеся области, используя инструмент Волшебная палочка [image: Инструмент Волшебная Палочка (W)], удерживая при этом нажатой клавишу <Shift>.
[image: Выделение изображения]
7. Инвертируйте выделение, выполнив команду Выделение ► Инвертировать выделение, или воспользуйтесь «горячими» клавишами <Ctrl>+<Shift>+<I>.
Перейдите к окну с Schtirlitz.jpg.
Выделенное изображение поместите в буфер обмена с помощью команды Редактирование ► Копировать (<Ctrl>+<C>).
[image: Копирование изображения]
8. Вставьте изображение командой Редактирование ► Вставить (<Ctrl>+<V>).
[image: Встравка изображения]
9. На слое с изображением девушки измените её размер командой меню Редактирование ► Трансформация ► Масштаб (Для изменения размеров с сохранением пропорций удерживайте нажатой клавишу <Shift>).
Переместите изображение девушки поближе к машине.
[image: Трансформация изображения]
10. Инструментом Пипетка [image: Инструмент Пипетка (I)]выберите цвет тени под машиной. На слое с машиной инструментом Кисть [image: Инструмент Кисть (B)]с нечёткими краями аккуратно дорисуйте тень от девушки.
11. Отрегулийте цветовую гамму слоя с девушкой. Постарайтесь выполнить её в тонах, близких к тонам изображения с машиной. Для этого используйте окно Кривые, которое вызывается командой Изображение ► Регулировки ► Кривые (<Ctrl>+<M>)
[image: Окно Кривые]
Окно Кривые
12. Объедините слои командой Слой ► Выполнить сведение. Готовое изображение сохраните в своей папке.
Готовое изображение
[image: готовое изображение]
[bookmark: _Toc398806127]Лабораторная работа №2
Тема: Магнитное лассо
Цель: научиться использовать инструмент магнитное лассо.
Задание 1:
1. Откройте приложение Adobe Photoshop
[image: media/source_pictures/eagle.zip]
2. Загрузите файл Eagle.psd 
3. Увеличьте масштаб изображения до 200-300% и далее работайте с таким масштабом. Для перемещения по изображению используйте палитру Навигатор или инструмент Рука [image: Инструмент Рука(H)].
4. Используя инструмент Магнитное лассо [image: Инструмент Магнитное лассо (L)], выделяйте отдельные чёрные перья и с помощью инструмента Заливка [image: Инструмент Заливка (G)]раскрасьте орла в разные цвета.
Совет:
· Цвета заливки выбирайте самостоятельно на палитрах Цвет и Образцы или в окне Сборщик цветов. Это окно можно вызвать двойным щелчком на кнопках установки цвета фона и переднего плана на Палитре инструментов.
	[image: http://www.modern-computer.ru/images/practice/photoshop/comimg/6.jpg]
	[image: http://www.modern-computer.ru/images/practice/photoshop/comimg/5.jpg]
	[image: http://www.modern-computer.ru/images/practice/photoshop/comimg/4.jpg]

	Палитра Цвет
	Палитра Образцы
	Палитра Сборщик цветов


· Если Заливка закрашивает слишком много или слишком мало, то отрегулируйте параметр Чувствительность (значение должно быть в диапазоне от 0 до 255).
· Вместо инструмента Заливка можно использовать Кисть [image: Инструмент Кисть (B)]или Аэрограф [image: Включить возможности пульверизатора].
5. В результате у вас получится птица, больше похожая на попугая, чем на орла. Готовое изображение сохраните в своей папке.
Готовое изображение
[image: готовое изображение]

Задание 2:
1. Откройте приложение Adobe Photoshop
[image: media/source_pictures/vegetables.zip]
2. Загрузите файл vegetables.psd 
3. Создайте новый рисунок командой Файл ► Новый (<Ctrl>+<N>). Укажите следующие парамерты нового рисунка:
	Ширина:
	300 пикселей
	
	[image: Окно Имя]
Окно Имя

	Высота:
	400 пикселей
	
	

	Разрешение:
	72 пиксели/дюйм
	
	

	Режим:
	RGB
	
	

	Содержание (фон):
	Белый
	
	


4. Выделяя с помощью инструмента Магнитное лассо [image: Инструмент Магнитное лассо (L)]и Многоугольное лассо [image: Инструмент Многоугольное лассо (L)]поочерёдно разные овощи, создайте на новом рисунке изображение «Повара»
[image: Магнитное и многоугольное лассо]
5. Объедините слои командой Слой ► Выполнить сведение. Готовое изображение сохраните в своей папке.
Готовое изображение
[image: готовое изображение]

Задание 3:
1. Откройте приложение Adobe Photoshop
2. Загрузите файлы: camel.jpg и dog.jpg 
[image: media/source_pictures/camel.zip][image: media/source_pictures/dog.zip]
3. Выделите голову верблюда (с учётом замкнутых областей) и скопируйте в буфер обмена.
[image: Выделение и копирование изображения]
4. Вставьте голову верблюда в рисунок с собакой.
[image: Вставка изображения]
5. Командой Редактирование ► Трансформация ► Масштаб измените размер головы верблюда. Выровняйте верблюда относительно собаки.
[image: Трансформация изображения]
6. Инструментом Ластик [image: Инструмент Ластик (E)]с мягкими краями аккуратно удалите лишние детали головы верблюда.
[image: Инструмент Ластик]
7. В окне Цветовой баланс, которое вызывается командой Изображение ► Регулировки ► Цветовой баланс (<Ctrl>+<B>) измените цветовую гамму слоя с верблюдом так, чтобы она была близка к цветовой гамме собаки.
[image: Окно Цветовой балланс]
Окно Цветовой балланс
8. Инструментами Штамп копий [image: Инструмент Штамп копий (S)]и Палец [image: Инструмент Палец (R)]устраните оставшиеся недостатки изображения.
[image: Готовое изображение]
9. Объедините слои командой Слой ► Выполнить сведение.
Готовое изображение сохраните в своей папке.
Готовое изображение
[image: готовое изображение]
[bookmark: _Toc398806128]Лабораторная работа №3

Тема: Базовые операции при редактировании изображений. Инструменты выделения и рисования
Цель: научиться с помощью инструментов выделения и рисования изменять изображения.
Задание 1:
1. Откройте приложение Adobe Photoshop
2. Загрузите файл men.jpg 
[image: media/source_pictures/men.zip]

3. Перейдите к рисунку с изображением человека. Постарайтесь улучшить качество изображения, воспользовавшись командой Изображение ► Регулировки ► Авто Уровни (<Ctrl>+<Shift>+<L>) и окном Кривые Изображение ► Регулировки ► Кривые (<Ctrl>+<M>)
[image: Улучшение качества изображения]
4. Выделите с помощью инструмента Волшебная палочка [image: Инструмент Волшебная Палочка (W)]задний фон изображения.
[image: Выделение изображения]

5. Теперь необходимо несколько расширить выделение, чтобы исключить случайные области. Для этого выполните команду Выделение ► Модифицировать ► Расширить.
В открывшемся окне Выбор расширения установить <Расширить на 2 пикселя>
[image: Окно Выбор расширения]

Окно Выбор расширения
6. Не отменяя выделения, выберите инструмент Градиент [image: Инструмент Градиент (G)].
7. [image: Цвета переднего плана и фона]Инструментом Цвета переднего плана и фона установите цвета переднего плана и фона, выбрав в окне Сборщик цветов следующие составляющие:
	для переднего плана:
	
	для фона:
	
	[image: http://www.modern-computer.ru/images/practice/photoshop/comimg/23.gif]
Окно Сборщик цветов

	R:
	14
	
	R:
	94
	
	

	G:
	218
	
	G:
	43
	
	

	B:
	211
	
	B:
	162
	
	


8. На панели инструмента Градиент выберите тип градиента Foreground to Background (от цвета переднего плана к фону).
[image: http://www.modern-computer.ru/images/practice/photoshop/comimg/24.gif]
Панель инструмента Градиент
9. Поэкспериментируйте с различными направлениями и типами (Линейный, Радиальный, Угловой, Отражённый, Ромбовидный) и видами переходов градиента.
[image: Градиентная заливка]
10. Готовое изображение сохраните в своей папке.
Готовые изображения
[image: Готовое изображение][image: Готовое изображение]

[image: Готовое изображение][image: Готовое изображение]

Задание 2:
1. Откройте приложение Adobe Photoshop
2. Загрузите файл fruits.tif 
[image: media/source_pictures/fruits.zip]
3. Поверх слоя с изображением создайте новый слой командой Слой ► Новый ► Слой... (<Ctrl>+<Shift>+<N>) (можно воспользоваться кнопкой Создать новый слой [image: Создать новый слой], расположенной на палитре Слои).
[image: Палитра Слои]
Палитра Слои
4. На палитре Слои в выпадающем списке Установить режим смешивания установите режим Цвет
5. Выберите инструмент Кисть [image: Инструмент Кисть (B)]с твёрдыми краями.
[image: Настройки Кисти]
Настройки Кисти
6. Выбирая необходимые цвета инструментом Цвета переднего плана и фона, начните раскрашивать изображение.
[image: Инструмент Цвета переднего плана и фона]
Инструмент Цвета переднего плана и фона
7. Объедините слои командой Слой ► Выполнить сведение.
Готовое изображение сохраните в своей папке.
Готовое изображения
[image: Готовое изображение]

Задание 3: Урок создания S-образного изгиба для шапки веб-страниц.
1. Создайте новое изображение командой Файл ► Новый (<Ctrl>+<N>). Укажите следующие парамерты нового рисунка:
	Ширина:
	500 пикселей
	
	[image: Окно Имя]
Окно Имя

	Высота:
	45 пикселя
	
	

	Разрешение:
	72 пиксели/дюйм
	
	

	Режим:
	RGB цвет
	
	

	Содержание (фон):
	Белый
	
	


2. Создайте новый слой
3. В новом слое инструментом Эллипс [image: Инструмент Овальная область(M)]создайте круглое выделение в левом верхнем углу изображения:
[image: Создание круглого выделения]
4. Удерживая нажатой клавишу <Shift>, добавьте к круглому выделению прямоугольное
[image: Добавление прямоугольного выделения]
5. Инструментом Заливка [image: Инструмент Заливка(G)]залейте выделенную область синим цветом.
[image: Заливка цветом выделенной области]
6. С помощью инструмента Перо [image: Инструмент Перо(P)]отметьте точки, как показано на рисунке. Это будет маршрутом для выделения. Две ключевые точки, отмеченные на рисунке, расположите так, чтобы образовалась диагональ между ними. Чем длиннее эта диагональ, тем плавней будет S-образный изгиб.
[image: Добавление ключевых точек]
7. Выберите инструмент Преобразование точки [image: Инструмент Преобразование точки(P)]и щелкнув по ключевым точкам, тяните горизонтально, чтобы получить нужный вам изгиб.
[image: Преобразование изображения кривыми Безье]
8. После подготовки маршрута, вам нужно его выделить, с помощью нажатия на кнопку Загрузить путь как выделение [image: Загрузить путь как выделение], которая находится в палитре Пути.

После этого возвратитесь к палитре Слои), выберете слой с изображением и нажмите клавишу Delete, чтобы вырезать выделение.
[image: Загрузка пути в выделение]
 
9. В палитре Пути удалите созданный контур.
10. Удалите ненужное продолжение, используя Инструментом Прямоугольник [image: Инструмент Прямоугольная область(M)].
11. Командой Слой ► Эффекты слоя ► Рельефность придайте изображению объём
12. Готовое изображения сохраните в своей папке.
Готовое изображения
[image: Готовое изображение]
[bookmark: _Toc398806129]Лабораторная работа №4

Тема: Базовые операции при редактировании изображений.
Цель: научиться редактировать изображение с помощью различных операций
Задание 1:
1. Откройте приложение Adobe Photoshop
2. Загрузите файл dessert.tif 
[image: media/source_pictures/dessert.zip]
3. Переведите изображение в чёрно-белый режим командой Изображение ► Режим ► Чёрно-белый. После этого вся информация о цвете данного изображения стирается. В результате должна получиться обычная чёрно-белая фотография.
4. На палитре Слои в выпадающем списке Установить режим смешивания установите режим Цвет
5. Готовое изображение сохраните в своей папке.
Готовое изображения
[image: Готовое изображение]
Задание 2:
1. Откройте приложение Adobe Photoshop
2. Загрузите файл oldfoto.tif 
[image: media/source_pictures/oldfoto.zip]
3. Переведите изображение в чёрно-белый режим командой Изображение ► Режим ► Чёрно-белый. Ретуширование производите используя инструменты инструмент Кисть [image: Инструмент Кисть (B)]и Штамп копий [image: Инструмент Штамп копий (S)].
При необходимости используйте инструмент цветокоррекции Изображение ► Регулировки ► Яркость/Контрастность.
4. Готовое изображение сохраните в своей папке.
Готовое изображения
[image: Готовое изображение]
Задание 3:
1. Откройте приложение Adobe Photoshop
2. Загрузите файлы: beach.TIF и factory.TIF
[image: media/source_pictures/beach.zip][image: media/source_pictures/factory.zip]
Обязательное условие – первая и вторая фотографии должны быть одинаковыми по размеру (хотя бы по ширине).
3. Сделайте активной фотографию beach.TIF. Перейдите в режим быстрой маски, нажав на клавиатуре «горячую клавишу» <Q>.
4. Установите цвета фона и переднего плана белый и чёрный.
[image: Установка цвета фона и переднего плана]
5. Инструментом Градиент [image: Инструмент Градиент (G)], залейте изображение сверху вниз с переходом от цвета переднего плана к цвету фона.
[image: http://www.modern-computer.ru/images/practice/photoshop/comimg/65.png]
Поскольку Вы в режиме Быстрой Маски, то белый цвет выглядит прозрачным, а черный красным. Чем краснее, тем прозрачнее будет это место на картинке.
[image: Режим быстрой маски]
6. Вернитесь в обычный режим редактирования нажатием «горячей клавиши» <Q>.
Вы получите выделение, большая часть которого будет невидимой, так как пиксели выделены частично.
[image: Режим быстрой маски]
7. Сделайте активной вторую фотографию.
Выделите всё изображение командой Выделение ► Всё, или воспользуйтесь «горячими» клавишами <Ctrl>+<A>.
Выделенное изображение поместите в буфер обмена с помощью команды Редактирование ► Копировать (<Ctrl>+<C>).
[image: Копирование изображения]
8. Снова сделайте активной первую фотографию.
Вставьте изображение командой Редактирование ► Вставить В (<Ctrl>+<Shift>+<V>).
[image: Вставка изображения]
9. Объедините слои командой Слой ► Выполнить сведение.
Готовое изображение сохраните в своей папке.
Готовое изображение
[image: Готовое изображение]
[bookmark: _Toc398806130]Лабораторная работа № 5

Тема: Текстовые эффекты
Цель: научиться работать с текстовыми эффектами.
Задание 1:
1. Откройте приложение Adobe Photoshop
2. Создайте новое изображение командой Файл ► Новый (<Ctrl>+<N>). Укажите следующие парамерты нового рисунка:
	Ширина:
	10 см
	
	[image: Окно Имя]
Окно Имя

	Высота:
	7 см
	
	

	Разрешение:
	72 пиксели/дюйм
	
	

	Режим:
	Чёрно-белое
	
	

	Содержание (фон):
	Белый
	
	


3. Инструментом Текст [image: Инструмент Текст(Т)]создайте надпись fire:
	Тип шрифта:
	Time New Roman
	
	[image: Параметры инструмента Текст]

	Начертание:
	Bold Italic
	
	

	Размер:
	150 пкс
	
	



[image: Создание надписи]
4. Инструментом Перемещение [image: Перемещение(V)]выровняйте надпись ближе к нижнему краю изображения.

[image: Перемещение изображения]
5. Склейте слои командой Слой ► Слить с нижним (<Ctrl>+<E>).
6. Кристаллизуйте надпись: Фильтр ► Pixelate ► Cristallize
	Cell Size (размер ячейки):
	3-5 пикселя
	
	[image: http://www.modern-computer.ru/images/practice/photoshop/comimg/32.gif]



[image: Кристализация изображения]
7. «Размойте» изображение: Фильтр ► Смазывание ► Смазывание Гаусса...
	Радиус:
	1 пиксель
	
	[image: http://www.modern-computer.ru/images/practice/photoshop/comimg/33.gif]



[image: Размытие изображения по Гауссу]
8. Инвертируйте изображение: Изображение ► Регулировки ► Инвертировать (<Ctrl>+<I>)

[image: Инвертирование изображения]
9. Поверните изображение: Изображение ► Повернуть Холст ► 90o против часовой стрелки

[image: Вращение изображения изображения]
10. Создайте язычки пламени: Фильтр ► Stylize ► Wind...
	Для усиления язычков примените фильтр несколько раз
	
	[image: http://www.modern-computer.ru/images/practice/photoshop/comimg/34.gif]


[image: Применение фильтра Wind]
11. Для реалистичности добавьте колебания: Фильтр ► Distort ► Ripple...
	Amount (эффект):
	50%
	
	[image: http://www.modern-computer.ru/images/practice/photoshop/comimg/35.gif]

	Size (размер):
	Medium
	
	



[image: Применение фильтра Distort]
12. Поверните изображение: Изображение ► Повернуть Холст ► 90o по часовой стрелке

[image: Вращение изображения изображения]
13. Примените ещё раз: Фильтр ► Distort ► Ripple...
	Amount (эффект):
	30%
	
	[image: http://www.modern-computer.ru/images/practice/photoshop/comimg/35.gif]

	Size (размер):
	Lage
	
	



[image: Применение фильтра Distort]
14. Раскрасте пламя: Изображение ► Режим ► Индексированные Цвета
	Сопоставьте пламени цветовую модель:
Изображение ► Режим ► Палитра.
В окне Таблица цветов выберите BlackBody
	
	[image: http://www.modern-computer.ru/images/practice/photoshop/comimg/36.gif]

	
	
	



[image: Применение фильтра Distort]
15. Готовое изображения сохраните в своей папке.
Готовое изображения

[image: Готовое изображение]

Задание 2:
1. Откройте приложение Adobe Photoshop
2. Создайте новое изображение командой Файл ► Новый (<Ctrl>+<N>). Укажите следующие парамерты нового рисунка: 
	Ширина:
	10 см
	
	[image: Окно Имя]
Окно Имя

	Высота:
	7 см
	
	

	Разрешение:
	72 пиксели/дюйм
	
	

	Режим:
	Чёрно-белое
	
	

	Содержание (фон):
	Белый
	
	


3. Добавьте новый слой Слой ► Новый ► Слой... (<Shift>+<Ctrl>+<N>) и залейте его белым цветом с помощь. инструмента Заливка [image: Инструмент Заливка (G)].
4. Инструментом Текст [image: Инструмент Текст(Т)] создайте надпись ice: 
	Тип шрифта:
	Time New Roman
	
	[image: Параметры инструмента Текст]

	Начертание:
	Bold Italic
	
	

	Размер:
	180 пкс
	
	

	Цвет:
	Черный
	
	



[image: Создание надписи]
5. Инструментом Перемещение [image: Перемещение(V)] выровняйте надпись ближе к верхнему краю изображения (внизу оставьте место для сосулек).

[image: Перемещение изображения]
6. Склейте слои командой Слой ► Слить с нижним (<Ctrl>+<E>).
7. Кристаллизуйте надпись: Фильтр ► Pixelate ► Cristallize 
	Cell Size (размер ячейки): 
	6-8 пикселей
	
	[image: http://www.modern-computer.ru/images/practice/photoshop/comimg/32.gif]



[image: Применение фильтра Кристализация]
8. Придайте шероховатость ледяной поверхности: Фильтр ► Шум ► Добавить шум: 
	Количество:
	70
	
	[image: Окно Добавить шум]
Окно Добавить шум

	Распределение:
	Гауссовское
	
	

	Одноцветный:
	
	
	



[image: Применение фильтра Шум]
9. Смягчите полученный эффект: Фильтр ► Смазывание ► Смазывание Гаусса... 
	Радиус: 
	1,5-2 пикселя
	
	[image: http://www.modern-computer.ru/images/practice/photoshop/comimg/33.gif]



[image: Применение фильтра Смазывание Гаусса]
10. Произведите цветокоррекцию: Изображение ► Регулировки ► Кривые... (<Ctrl>+<M>)
[image: http://www.modern-computer.ru/images/practice/photoshop/task_2_3/6.gif]

[image: Цветокоррекция изображения]
Склейте слои командой Слой ► Слить с нижним (<Ctrl>+<E>).
11. Инвертируйте изображение: Изображение ► Регулировки ► Инвертировать (<Ctrl>+<I>)

[image: Инвертирование изображения]
12. Поверните изображение: Изображение ► Повернуть Холст ► 90° против часовой стрелки

[image: Вращение изображения изображения]
13. Создайте сосульки: Фильтр ► Stylize ► Wind... 
	Direction (направление): From the Right (Справа)
	
	[image: http://www.modern-computer.ru/images/practice/photoshop/comimg/34.gif]

	
	
	



[image: Применение фильтра Wind]
14. Верните изображение: Изображение ► Повернуть Холст ► 90° против часовой стрелке

[image: Вращение изображения изображения]
15. Переведите изображение в цветовой режим: Изображение ► Режим ► RGB цвет
16. Раскрасте изображение:
Изображение ► Регулировки ► Тон/насыщенность 
	Установить флажок
Тонирование: 
	

	
	[image: http://www.modern-computer.ru/images/practice/photoshop/comimg/39.gif]

	Тон: 
	191
	
	

	Насыщенность: 
	77
	
	

	Яркость: 
	3
	
	


17. Загрузитe кисти (Program_files/ Photoshop/ Goodies/ Brushes/ Assorted Brushes.abr).
Выберите опцию Включить возможности пульверизатора [image: Включить возможности пульверизатора] и создайте эффект искрящегося льда.

[image: Применение фильтра Distort]
18. Готовое изображения сохраните в своей папке. 
[image: Готовое изображение]

Задание 3:
1. Откройте приложение Adobe Photoshop
2. Создайте новое изображение:
	Ширина:
	15 см
	
	[image: Окно Имя]
Окно Имя

	Высота:
	7 см
	
	

	Разрешение:
	72 пиксели/дюйм
	
	

	Режим:
	RGB цвет
	
	

	Содержание (фон):
	Белый
	
	


3. Залейте фон нежно-голубым цветом __.

[image: Заливка фона изображения]
4. Напишите текст в оттенках тёмно-синего цвета __.

[image: Создание надписи на изображении]
5. Добавьте новый слой.
6. На новом слое Кистью или Пульверизатором (аэрографом) с размытыми краями нанесите краску туда, где скопился бы снег, если бы он падал на надпись сверху.

[image: Использование инструмента Кисть или Аэрограф]
7. Инструментом Палец [image: Инструмент Палец (R)]смажьте края снега, как будто он под своей тяжестью стал нависать над буквами.
Имитируйте наплывы снега, смазывая снег в вертикальном направлении.

[image: Инстумент Палец]
8. Добавьте шум: Фильтр ► Шум ► Добавить шум
	Количество:
	16%
	
	[image: http://www.modern-computer.ru/images/practice/photoshop/comimg/38.gif]

	Распределение:
	Униформа
	
	

	Одноцветный:
	
	
	


[image: Применение фильтра Шум]
9. Примените фильтр: Фильтр ► Смазывание ► Смазывание...

[image: Инстумент Смазывание]
10. Нанесите снежинки Кистью

[image: Инстумент Кисть]
11. Склейте слои
12. Готовое изображения сохраните в своей папке.

[image: Готовое изображение]
[bookmark: _Toc398806131]Лабораторная работа № 6

Тема: «Создание текстур»
Цель: научиться создавать различные текстуры
Задание 1:
1. Откройте приложение Adobe Photoshop
2. Создайте новое изображение: 
	Ширина:
	300 пикселей

	Высота:
	300 пикселей

	Разрешение:
	72 пиксели/дюйм

	Режим:
	RGB цвет

	Содержание (фон):
	Белый


3. Залейте фон цветом деревянных оттенков __.

[image: Заливка фона изображения]
4. Добавьте шум: Фильтр ► Шум ► Добавить шум 
	Количество:
	50%

	Распределение:
	Униформа

	Одноцветный:
	



[image: Применеие к изображению фильтра Шум]
5. Превратите изображение в гладкую деревяннцю поверхность, применив фильтр: Фильтр ► Смазывание ► Смазывание движения 
	Искажение:
	0°

	Дистанция:
	300 пикселей



[image: Применение к изображению фильтра Смазывание движения]
6. Произведите смещение: Фильтры ► Другие ► Смещение... 
	Горизонтальный:
	150

	Вертикальный:
	150



[image: Применение к изображению фильтра Смещение]
7. Ещё раз примените фильтр: Фильтр ► Смазывание ► Смазывание движения 
	Искажение:
	0°

	Дистанция:
	300 пикселей



[image: Применение к изображению фильтра Смазывание движения (Motion Blur)]
8. Придайте текстуре естественный, природный вид, применив в разных выделениях фильтр Фильтр ► Distort ► Pinch
Эффект подберите «на глаз». 

[image: Применение к изображению фильтра Distort Pinch]
9. В разных выделениях примените фильтр Фильтр ► Distort ► Twirl
так же с настройками «на глаз». 

[image: Применение к изображению фильтра Distort Twirl]
10. Готовое изображения сохраните в своей папке. 
Готовое изображения

[image: Готовое изображение]

Задание 2:
1. Откройте приложение Adobe Photoshop
2. Создайте новое изображение квадратной формы: 
	Ширина:
	400 пикселей

	Высота:
	400 пикселей

	Разрешение:
	72 пиксели/дюйм

	Режим:
	RGB цвет

	Содержание (фон):
	Белый


3. Установите цвета фона и переднего плана белый и чёрный

[image: Установка цвета фона и переднего плана]
4. Примените фильтр Облака: Фильтр ► Render ► Clouds. 

[image: Применеие к изображению фильтра Render Clouds]
5. Примените фильтр: Фильтры ► Sketch ► Chrome...
	Detail:
	5

	Smoothness:
	7



[image: Применение к изображению фильтра Sketch Chrome]
6. Раскрасьте изображение: Изображение ► Регулировки ► Цветовой балланс
Цветовые уровни: -40, +42, +85. 

[image: раскрашивание изображения командой Регулировки Цветовой баланс]
7. Создайте новый слой. 
8. Примените фильтр Облака: Фильтр ► Render ► Clouds. 

[image: Применеие к изображению фильтра Render Clouds]
9. Примените фильтр: Фильтры ► Sketch ► Chrome...
	Detail:
	 5

	Smoothness:
	 7



[image: Применение к изображению фильтра Sketch Chrome]
10. Раскрасте изображение:
11. Изображение ► Регулировки ► Тон/насыщенность 
	Установить флажок
Тонирование:
	


	Тон:
	216

	Насыщенность:
	25

	Яркость:
	-11



[image: Раскрашивание изображения командой Тон Насыщенность]
12. Установите прозрачность верхнего слоя 40%. 

[image: Свойства слоя с изображением. Прозрачность слоя]
13. Перейдите к нижнему слою. 
14. Примените фильтр:
Фильтры ► Distort ► Twirl...
Angle: 285° 

[image: Применение к изображению фильтра Distort Twirl]
15. Готовое изображения сохраните в своей папке. 
[image: Готовое изображение]

Задание 3:
1. Откройте приложение Adobe Photoshop
2. Создайте новое изображение квадратной формы: 
	Ширина:
	400 пикселей

	Высота:
	400 пикселей

	Разрешение:
	72 пиксели/дюйм

	Режим:
	RGB цвет

	Содержание (фон):
	Белый


3. По диагонали примените линейный градиент с переходом между любыми цветами
[image: Использование инструмента Линейный градиент]
4. Примените радиальный градиент в режиме Разница 
[image: Использование инструмента Радиальный градиент в режиме Разница]
5. Далее можно поэкспериментировать с любыми градиентами в любых режимах. 
Готовые изображения
[image: Готовое изображение][image: Готовое изображение][image: Готовое изображение][image: Готовое изображение]

Задание 4:
Откройте приложение Adobe Photoshop
Создайте новое изображение квадратной формы: 
	Ширина:
	400 пикселей

	Высота:
	400 пикселей

	Разрешение:
	72 пиксели/дюйм

	Режим:
	RGB цвет

	Содержание (фон):
	Белый


1. По диагонали примените линейный градиент с переходом между большим количеством любых цветов.
[image: Использование инструмента Линейный градиент]
2. Перейдите в палитру каналов, и выбирая поочерёдно каждый канал используемой цветовой модели, применить к нему различные фильтры, например, фильтром Twirl,
Angle = 430°. 
[image: Применение к слою с изображением фильтра Twirl]
3. При работе с каналами можно использовать не только фильтры, но и уровни и кривые. 
Готовые изображения

[image: Готовое изображение][image: Готовое изображение][image: Готовое изображение][image: Готовое изображение]

[bookmark: _Toc398806132]Лабораторная работа № 7

Тема: эффекты имитации.
Цель научиться использовать эффекты имитации.
1. Откройте приложение Adobe Photoshop
2. Откройте изображение rain.jpg 

[image: Исходное изображение для редактирования]
Создайте новый слой. 
Залейте новый слой белым или чёрным цветом. 
Добавьте шум: Фильтр ► Шум ► Добавить шум 
	Количество:
	400%

	Распределение:
	Униформа

	Одноцветный:
	


[image: Применение к изобраажению фильтра Добавить шум]
Придайте форму струй дождя, применив фильтр Motion Blur: Фильтр ► Смазывание ► Смазывание движения 
	Искажение:
	-63°

	Дистанция:
	44 пикселя


[image: Применение к изобраажению фильтра Motion Blur (Смазывание движения)]
1. Установите в параметрах слоя: 
	Режим смешивания:
	 


[image: Установка для слоя с изображением режима смешивания]
2. Уменьшить толщину струй Изображение ► Регулировки ► Уровни:
[image: http://www.modern-computer.ru/images/practice/photoshop/task_4_2/6.gif]

[image: Применение к изображению инструмента Регулировки Уровни]
3. Создайте новый слой. 
4. Установите цвета фона и переднего плана белый и чёрный 
[image: Установка цвета фона и переднего плана]
5. На новом слое примените линейный градиент: переход Foreground to Background (из основного цвета в фон). Белая часть градиента внизу, чёрная – вверху. 
[image: Заливка изображения линейным градиентом]
6. Установите в параметрах слоя с градиентом: 
	Режим смешивания:
	


[image: Применение к слою с изображением режима смешивания]
7. Подкорректируйте, если надо, прозрачность слоя. 
[image: Изменение прозрачности слоя с изображением]
8. Склейте слои. Готовое изображения сохраните в своей папке. 
Готовое изображения
[image: Готовое изображение]

[bookmark: _Toc398806133]Лабораторная работа № 8

Тема: Создание рамок.
Цель: научиться создавать градиентную и художественную рамку.
Задание 1:
1. Откройте приложение Adobe Photoshop
2. Откройте изображение Avto.tif 
[image: Исходное изображение для редактирования]
3. Создайте новый канал в палитре каналов. 
4. Возьмите инструмент Градиент [image: Инструмент Градиент(G)]. 
5. Установите цвет переднего плана – белый. 
[image: Установка цвета переднего плана]
6. В настройках градиента выбрать тип Foreground To Transparent (Основной цвет в прозрачный). 
[image: Установка типа градиента]
7. Залитйте линейным градиентом новый канал, как показано на рисунке: 
[image: Заливка изображения линейным градиентом]
8. Примените фильтр: Фильтр ► Смазывание ► Смазывание Гаусса...
Радиус: 2,6 пикселя. 

[image: Применение к изображению фильтра смазывание Гаусса]
9. Для придания неоднородности поверхности добавьте шум: Фильтр ► Шум ► Добавить шум 
	Количество:
	10%

	Распределение:
	Униформа

	Одноцветный:
	


[image: Применение к изображению фильтра Добавить шум]
10. Перейдите в PGB-канал 

[image: Исходное изображение для редактирования]
11. Загрузите канал в выделение, щелкнув по нему мышью с нажатой клавишей <Ctrl>. 

[image: Загрузка канала в выделение]
12. Установите цвет переднего плана чёрный __, а цвет фона белый __.
(Можно поэкспериментировать с другими цветами). 

[image: Установка цвета фона и переднего плана]
13. Примените выделенной области фильтр Облака: Фильтр ► Render ► Clouds. 

[image: Применение к изображению фильтра Clouds (Облака)]
14. Подкорректируйте изображение одной из команд коррекции изображения: Тон/Насыщенность, Яркость/Контрастность, Кривые из меню Изображение ► Регулировки 

[image: Корректировка изображения с использованием тоновых кривых]
15. Отмените выделение 
16. Склейте слои. Готовое изображение сохраните в своей папке. 
Готовое изображение
[image: Готовое изображение]


Задание 2:
1. Откройте приложение Adobe Photoshop
2. Откройте изображение Evening.tif 

[image: Исходное изображение для редактирования]
3. Создайте новый канал в палитре каналов. 
4. На новом канале инструментом Прямоугольное выделение создайте прямоугольник. 
5. Инвертируйте выделение: Выделние ► Инвертировать выделение. 
6. Залейте полученную область белым цветом. 

[image: Заливка изображения белым цветом]
7. Отмените выделение. 
8. Примените к каналу фильтр Brush Strokes: Фильтр ► Brush Strokes ► Sprayed Strokes
	Stroke Length:
	18

	Spray Radius:
	23

	Stroke Direction:
	



[image: Применение к изображению фильтра Brush Strokes]
9. Перейдите в PGB-канал. 

[image: RGB-канал изображения]
10. Загрузите канал в выделение, щелкнув по нему мышью с нажатой клавишей <Ctrl>. 

[image: Загрузка канала в выделение]
11. Залейте выделение любым подходящим цветом. 

[image: Заливка изображения цветом]
12. Отмените выделение. 
13. Готовое изображение сохраните в своей папке. 
[image: Готовое изображение]

[bookmark: _Toc398806134]Лабораторная работа № 9

Тема: применение фильтров, имитация объема
Цель: научиться рисовать трехмерные объекты.
1. Откройте приложение Adobe Photoshop
2. Создайте новое изображение: 
	Ширина:
	300 пикселей

	Высота:
	300 пикселей

	Разрешение:
	72 пиксели/дюйм

	Режим:
	RGB цвет

	Содержание (фон):
	Белый


3. Создайте новый слой. 
4. На новом слое создайте круглое выделение и залейте его любым цветом. 

[image: Заливка изображения цветом]
5. Cоздайте новый слой. 
6. Примените: Фильтр ► Render ► Lighting Effects...
со следующими параметрами: 
	Style:
	

	Light type:
	

	On:
	

	Intensity:
	35

	Focus:
	69

	Gloss:
	0

	Material:
	69

	Exposure:
	0

	Ambience:
	8

	Texture channal:
	

	White is high:
	

	Height:
	50


[image: Окно Lighting Effects]

[image: Применение к изображению фильтра Lighting Effects]
7. Для увеличения реалистичности пустить по шару блики фильтром Фильтр ► Render ► Lens Flare... 

[image: Применение к изображению фильтра Lens Flare]
8. Применить к слою с шаром эффект слоя Тень 

[image: Применение к изображению эффектов слоя]
9. Склейте слои. Готовое изображение сохраните в своей папке. 
Готовое изображение
[image: Готовое изображение]

[bookmark: _Toc398806135]Лабораторная работа № 10
Тема: создание изображений с помощью инструментов раскрашивания. 
Цель: научиться и раскрашивать изображения. Научиться работать с контурами.
Каждый слой соответствует определенной детали рисунка или определенному цвету, все раскрашивается разными цветами или градиентами поочередно и соединяется в одно целое. Основное в такой работе – умение работать с инструментами выделения, а для этого нужна усидчивость и скрупулезность.
Но, не многие могут работать с панелью слоев, а именно будем применять режим наложения, когда один слой взаимодействует определенным образом с другим. И это замечательное подспорье в раскрашивании с большим списком параметров, из них мы сегодня рассмотрим только три, для примера.
Возьмем черно- белую картинку и загрузим ее в фотошоп — «Файл» => «Загрузить».
Я взяла картинку из интернета, этот рисунок в виде портрета, подойдет для аватарки.
[image: Как раскрасить черно-белый рисунок]
Как раскрасить черно-белый рисунок
Вначале нужно разукрасить лицо и волосы, а затем уже все остальные детали.
Для этого создадим новый слой.
[image: Как раскрасить черно-белый рисунок]
Как раскрасить черно-белый рисунок
Дадим ему название.
[image: Как раскрасить черно-белый рисунок]
Как раскрасить черно-белый рисунок
Кисточку я взяла такую(66):
[image: Как раскрасить черно-белый рисунок]
Как раскрасить черно-белый рисунок
Для лица я взяла цвет — eed6be, а для волос — dfbd8f. Вы можете взять совсем другие цвета, возможно для лица нужен тон немного светлее. Меняя, по потребности, радиус кисти, раскрашиваем на этом слое лицо и волосы.
Если где-то вылезли за край – не беда, все можно подправить ластиком.
Разукрасили? В панели слоев выбираем «Умножение», обычно этот параметр применяем для тех участков рисунка, которые требуют полного закрашивания.
[image: Как раскрасить черно-белый рисунок]
Все штрихи рисунка, которые были закрашены, опять стали видны, правда, цвет кожи и волос неестественно бледные.
[image: Как раскрасить черно-белый рисунок]
Создаем новый слой и заливаем его красным цветом.
[image: Как раскрасить черно-белый рисунок]
Как раскрасить черно-белый рисунок
Применяем к нему параметр слоя «Мягкий свет».
[image: Как раскрасить черно-белый рисунок]
[image: Как раскрасить черно-белый рисунок]
Вот теперь гораздо лучше.
Создаем еще один новый слой, для всех остальных деталей и раскрашиваем их.
Сейчас будем применять параметр слоя «Цветовой тон», так как одежда и другие детали не требуют полного закрашивания, как при заливке.
Вот здесь, нужно внимательно отнестись к раскрашиванию. Лучше небрежно выходить за рамки рисунка, закрашивая и линии, чем аккуратно доходить до линии не захватывая их.
Вот пример не докрашевания:
[image: Как раскрасить черно-белый рисунок]
[image: Как раскрасить черно-белый рисунок]
А вот правильное раскрашивание.
[image: Как раскрасить черно-белый рисунок][image: Как раскрасить черно-белый рисунок]
На слое с волосами, пройдемся ластиком с прозрачностью в 20% и нажимом в 50%, чтобы добавить имитацию блеска и кисточкой добавим немного тени.
Подправим ластиком свои огрехи и объединим слои. 

[bookmark: _Toc398806136]Лабораторная работа № 11.
Тема: выделение и трансформация областей. 
Цель: научиться выделять правильные области, всё изображение, области произвольной формы, области одного цвета; инвертировать выделение; расширять и сужать выделенную область; перемещать выделенные области; дублировать и удалять выделенные области;
1. Коллаж – изображение, созданное из частей нескольких разных изображений. Ваша задача – создать коллаж «Мечта» (см. образец). Запомните – неудачное действие (и даже несколько действий подряд) можно отменить, открыв пункт меню Редактирование, и выбрав команду Шаг назад.
[image: ]1.1. Запустите программу Photoshop и откройте в ней эти 3 файла саванна, тигр и котенок. 
1.2. Для выполнения работы нам потребуется выделять области изображения неправильной формы. Инструменты выделения Прямоугольная и Овальная области для этого не подходят. Найдите группу Лассо на панели Инструментов сверху, раскройте правой кнопкой, выберите инструмент выделения Лассо.
[image: ][image: котенок]1.3. Разверните на весь экран окно фотографии котенок. Инструментом Лассо попробуйте точно обвести голову котенка. Это сложно сделать мышью – малейшее неправильное движение и выделение не получается. Но вы можете сделать приблизительное выделение, а затем поправить его в более удобном режиме – Быстрая маска. Обведите голову и лапы котенка на фотографии, захватывая изображение с некоторым запасом, не слишком заботясь о точности и не затрачивая лишнее время, примерно так
[image: ]1.4. На панели инструментов, внизу, под инструментами и квадратами Основного/фонового цвета расположены 2 кнопки[image: ]: слева – Нормальный режим выделения, справа – Быстрая маска. Перейдите в режим Быстрой маски. Изображение разделилось на 2 области – покрытая красным и прозрачная. Граница красной области проходит там, где вы проводили выделение (красное – за границей выделения, прозрачное - выделено). Теперь при помощи инструментов Кисть [image: ] (рисует красное) и Ластик [image: ] (стирает красное) вы можете, сочетая подрисовывания и подтирания, аккуратно поправить границу выделения. При необходимости можно отменить неудачные мазки. Новая граница должна проходить по краю головы и лап котенка, как на рисунке справа. Поправив границу, вернитесь в Нормальный режим. 
1.5. Скопируйте обведенного котенка Редактирование→Скопировать. Сверните окно фотографии котенок и разверните окно фотографии саванна. Вставьте скопированную голову котенка в окно фотографии саванна командой  Редактирование→Вклеить. 
[image: ]1.6. Котенка необходимо а) - уменьшить, б) - повернуть и в) – передвинуть на место. Эти 3 действия можно выполнить через пункт меню Редактирование→Свободное трансформирование. Примените этот пункт – голова котенка будет помещена в прямоугольник с маркерами по краям.
 а) чтобы уменьшить величину изображения по вертикали или горизонтали, наведите курсор на 1 из маркеров, он должен принять вид стрелки ↔. Хватайте маркер угла мышью и двигайте, пока размер головы не покажется вам приемлемым. 
б) чтобы выполнить поворот головы, выведите курсор за пределы прямоугольника,  и он сменит свой вид на   . Зажав левую кнопку мыши, слегка поверните рисунок, чтобы спящий котенок казался мечтающим (см. образец). 
в) переместите котенка в угол – поставьте курсор внутри головы котенка так, чтобы он не касался кружка в центре и боковых линий, затем нажмите левую кнопку и тащите голову в нужное место. Повторяйте действия а), б), в), пока результат не станет схож с образцом. Тогда нажмите кнопку Enter, чтобы применить трансформацию. 
1.7. Выберите инструмент выделения Овальная область. Выделите область, соответствующую первому мечтательному облачку (см. образец). Выделив, зайдите в Редактирование и там нажмите Выполнить обводку (ширину штриха установите 4 пикселя, цвет выберите Черный (если он отличается)). Не снимая выделение, выберите Редактирование→Выполнить заливку (В пункте Использовать установите - Белый). Таким же образом нужно сделать еще 2 облачка, покрупнее.
1.8. Перейдите к фотографии тигр. Голову тигра выделите инструментом Овальная область, скопируйте. Вставьте ее в фотографию саванна, уменьшите и передвиньте, как на образце (снова нужно Свободное трансформирование). Теперь фотографию тигра нужно обвести, чтобы она стала содержимым главного облачка. Зайдите в Редактирование и там нажмите выполнить обводку.
[image: Готовое]Результат сохраните в свою папку под названием Мечта.jpg. Появится диалог, где вам будет предложено выбрать Качество jpg-файла. Установите показатель качества на максимум (12). Закройте фотографии саванны, котенка и тигр.
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Тема: создание анимации.
Цель работы: научить создавать анимированные изображения в формате gif в среде Adobe Photoshop.
Для работы воспользуйтесь следующими заготовками:
Если Вам не нравятся эти образцы, можете выбрать любые другие на свой вкус. Муху можно заменить на муравья, гусеницу, любое другое насекомое, которое можете сами нарисовать в Photoshop с помощью кисти. 
1. Откройте рис.  в среде Adobe Photoshop.
[image: roen][image: Musca_domestica]




2. Создайте новый слой.
3. Вставьте на новый слой изображение мухи. Для этого откройте в Adobe 
[image: ]Photoshop. С помощью Инструмента волшебная палочка 
 выделите белое пространство вокруг мухи, а затем с помощью Выделение- Инвертировать выделение выделите контур мухи, скопируйте его на новый слой.
4. С помощью Редактирование – Трансформация уменьшите размер мухи.
[image: roen]5. Дублируйте слой с изображением мухи. С помощью инструмента Перемещение [image: ]


Сместите положение мухи, относительно начального положения на предыдущем слое. Для этого используйте также функцию Трансформация – Поворот.
6. Дублируйте верхний слой и опять сместите положение мухи.  Проделайте эти действия, пока траектория движения мухи не замкнётся. 
[image: roenкопирование]


7. Отключите все слои кроме самого первого с изображением Мистера Бина и следующего за ним с изображением мухи.
8. Перейдите в редактор ImageReady для создания анимации. Для этого на панели инструментов нажмите кнопку [image: ].
[image: ]
[image: ]9. В нижней части окна ImageReady находится «раскадровка», на неё мы должны выложить меняющиеся через заданное время кадры, которые и будут составлять анимацию.
Нажимаем кнопку Создание дубликата кадра - 
Выключаем слой с первым положение мухи и включаем следующий слой. Таким образом размещаем все кадры на «раскадровке» для создания анимации.
[image: ]
[image: ]10. Устанавливаем временную выдержку каждого кадра 0.1 сек.
Нажимаем кнопку пуск 
11.Осталось сохранить в формате gif. Для этого в меню Файл в окне ImageReady    выбираем пункт Сохранить оптимизированное как, выбираем имя файла и формат файла - gif.
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1.Что значит RGB?
a.  Red, Green, Black
b.  Right, Good, Bad
c. Red, Green, Blue
d. Red, Great, Black
2.Графика, представляемая в памяти компьютера в виде совокупности точек, называется:
a. Растровой.
b. Векторной.
c. Трехмерной.
d. Фрактальной.
3.Качество растрового изображения оценивается:
a. Количество пикселей.
b. Количество пикселей на дюйм изображения.
c. Размером изображения.
d. Количеством бит в сохраненном изображении.
4. Элементарным объектов растровой графики является:
a. То, что рисуется одним инструментом.
b. Пиксель.
c. Символ.
d. Примитив.
5. Для чего необходима палитра «История»?
a. Содержит наборы инструментов с различными предустановленными параметрами.
b. Позволяет отменять выполненные действия, включая и те, которые не отменяются посредством сочетания клавиш Ctrl+Z.
c. Дает широкий круг возможностей выбора формы и размеров кисти.
d. Дает общее представление об изображении, его цветовом решении, размерах и помогает при просмотре и редактировании.
6. Изображения представленные посредством пикселей, то есть разложенные на элементы, называется:
a. Растровым.
b. Фрактальным
c. Трехмерным
d. Векторным
7. Сетка которую на экране образуют пиксели, называют:
a. Видеопамять;
b. Видеоадаптер;
c. Растр;
d. Дисплейный процессор.
8. Одной из основных функций графического редактора является:
a. Ввод изображений;
b. Хранение кода изображения;
c. Создание изображений;
d. Просмотр и вывод содержимого видеопамяти.

9. Кнопки панели инструментов, палитра, рабочее поле, меню образуют:
a. Полный набор графических примитивов графического редактора;
b. Среду графического редактора;
c. Перечень режимов работы графического редактора;
d. Набор команд, которыми можно воспользоваться при работе с графическим редактором.
10.  Пиксель на экране монитора представляет собой:
a. Минимальный участок изображения, которому независимым образом можно задать цвет
b. Двоичный код графической информации;
c. Электронный луч;
d. Совокупность 16 зерен люминофора.
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1. Какие инструменты относятся к инструментам выделения?
a. Прямоугольная область, лассо, карандаш;
b. Лассо, рамка, вертикальная строка;
c. Горизонтальная область, рамка, вертикальная строка.
2. Лассо выполняет функцию:
a. Перетаскивает выделенный объект;
b. Рисование распылителем;
c. Выделяет любую зону, которую нужно обвести мышкой.
3. Какой инструмент выполняет вырезание прямоугольного изображения?
a. Карандаш;
b. Обрезка границ;
c. Ластик.
4. Что такое градиент?
a. Инструмент выделения;
b. Плавное изменение цвета;
c. Рисование текста.
5. Какие инструменты относятся к инструментам ретуширования?
a. Размытие рисунка, пальцевая размазка, затемнение объекта;
b. Ластик, карандаш;
c. Перо, губка, карандаш.
6. Что такое захват цвета?
a. Копирование пикселов;
b. Плавное изменение цвета;
c. Установка такого же цвета как тот, на который только что кликнули.
7. Какой инструмент относят к инструментам удаления?
a. Ластик;
b. Кисть;
c. Перо.
8. Соотнесите инструмент и назначение:
a. Ластик;
b. Карандаш;
c. Градиент;
d. Обрезка;
e. Лассо.

1. плавное изменение цвета;
2. рисование;
3. удаление нарисованного объекта;
4. выделение областей;
5. обрезание прямоугольных областей.
9. Назначение кнопки Копирование пикселей?
a. Плавное изменение цвета;
b. После указания исходного места, удерживая клавишу Alt, водят по месту, где нужен рисунок, там появляется исходный рисунок;
c. Размытие рисунка.
10. Как называются панели инструментов Photoshop?
a. Стандартные
b.  Палитры
c.  набор кнопок
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	1. Одной из основных функций графического редактора является:
	a. масштабирование изображений;
b. хранение кода изображения;
c. создание изображений;

	2. Сетка из горизонтальных и вертикальных столбцов, которую на экране образуют пиксели, называется: 
	a. видеопамять;
b. видеоадаптер;
c. растр

	3. Выбери растровые форматы графических файлов
	a. CDR, WMF
b. EPC, EPS;
c. PSD, BMP

	4. Что это за инструмент в Photoshop? [image: http://gplinform.ucoz.ru/skyrs/15.bmp]
	a. Вырезание
b. Перемещение
c. Выделение контура

	5. Что это за инструмент в Photoshop? [image: http://gplinform.ucoz.ru/skyrs/9.bmp]
	a. Кисть историческая
b. Размытие
c. Штамп

	6. Что это за инструмент в Photoshop? [image: http://gplinform.ucoz.ru/skyrs/11.bmp]
	a. Штамп
b. Ластик
c. Объемная фигура


	7. Что это за инструмент в Photoshop?[image: http://gplinform.ucoz.ru/skyrs/16.bmp]
	a. Заметки
b. Текст
c. Штамп

	8. Что это за инструмент в Photoshop? [image: http://gplinform.ucoz.ru/skyrs/8.bmp]
	a. Кисть
b. Размытие
c. Градиент

	9. Что это за инструмент в Photoshop? [image: http://gplinform.ucoz.ru/skyrs/22.bmp]

	a. Масштаб
b. Размытие
c. Лассо

	10. В цветовой модели RGB установлены следующие параметры: 0, 255, 0. Какой цвет будет соответствовать этим параметрам?
	a. Черный
b. красный 
c. зеленый 
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Нарисуйте:
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